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Schliereneffekte sind uns allen bekannt, wir
haben sie schon als Luftspiegelung über
heißen Straßen oder hinter Flugzeugtrieb-
werken gesehen. Bereits im 17. Jahrhundert
beobachtete Robert Hooke diese „Schlieren“
und beschrieb sie 1665 auch in seiner Micro-
graphia [1]. Als ursächlich für dieses Phäno-
men erkannte schon Hooke die Dichteunter-
schiede im durchstrahlten Medium. 

Aber erst der Physiker August Töpler ent-
wickelte 1864 [2], also vor ca. 150 Jahren, die
„Schlierenmethode“ als ein wissenschaft-
liches Verfahren zur Visualisierung von
Strömungen (insbesondere in Gasen). Mit
der Schlierenmethode gelang es erstmals,
Dichteunterschiede bzw. Gradienten im
Brechungsindex in sonst homogenen Me-
dien (Gas und Flüssigkeiten, aber auch
Glas) sichtbar zu machen. 

Von Töpler stammt auch eine schöne Be-
schreibung und Definition des Begriffs
„Schliere“ als eine „kleine Partie von beliebi-

ger Gestaltung, deren Brechungsvermögen nur
um ein Geringes [..] abweicht“ [3, S. 5]. Diese
Definition wird bis heute in der Optik ver-
wendet: Als Schlieren wird also eine Re-
gion bezeichnet, in der der Brechungsin-
dex sich von dem des Umgebungsmedi-
ums unterscheidet, was dazu führt, dass
Licht, das diese Region durchläuft, anders
gebrochen wird als durch das umgebene
homogene Medium [10].

Später entwickelte Hubert Schardin Mitte
des 20. Jahrhunderts weitere Methoden zur
Anwendung und quantitativen Auswer-
tung von Schlierenabbildungen [4]. Bis
heute wurden zahlreiche weitere Varianten
vorgeschlagen, Schlieren experimentell ab-
zubilden und fotografisch zu dokumentie-
ren. Inzwischen wurden durch die Mög-
lichkeiten der digitalen Bildverarbeitung
zudem neue Methoden entwickelt, die es
gestatten, auch großformatige Objekte zu
untersuchen. 

In diesem Beitrag werden einige einfach
nachvollziehbare und auch mit einfachen
schulischen Mitteln sehr überzeugend re-
alisierbare Experimente zur Schlierenabbil-
dung bzw. -fotografie vorgestellt: der Fou-
cault-Aufbau, ein ‚low-cost’-Foucault-Auf-
bau, der klassische Aufbau nach Töpler, ein
modifizierter Aufbau nach Schardin und
eine Realisierung der Moiré-Methode.

1 Brechungsindex, Dichte und 
Temperatur
Der Brechungsindex nLuft in Luft beträgt bei
Normaldruck und -temperatur 

nLuft = 1,00028.

Ändert sich die Lufttemperatur, so ändert
sich auch ihre Dichte. Nach dem Gladsto-
ne-Dale-Gesetz n – 1 = r K hängt der Bre-
chungsindex n nahezu linear von der Dich-
te r ab, wobei K eine Materialeigenschaft
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Abb. 1: Strahlengang beim Foucault-Aufbau (mit Schlierenobjekt als geschlängelte Linie).
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ist, die im Bereich der sichtbaren Wellen-
längen weitgehend konstant ist. Dabei ist
zu bemerken, dass eine Änderung der
Dichte r in Luft um zwei Zehnerpotenzen,
also r’ = 100r, gerade einmal zu einer Ab-
weichung des Brechungsindex um nur cir-
ca 3 % (!) führt. 

Mit n’ – 1 = r’ K und r’ = 100r gilt: 

n’ – 1 = 100 r K = 100 (nLuft – 1)
= 100 (1,00028 – 1)  
⇒ n’ = 1,028
D.h.: n’/ nLuft ≈ 1,0277, also ca. 3 %.

Die Dichte r hängt zudem in etwa antipro-
portional von der Temperatur T ab: 

r ≈ 1 / T

Dieser Zusammenhang folgt aus der Dich-
tedefinition, der allgemeinen Gasgleichung
für ideale Gase bzw. der Van-der-Waals-Glei-
chung (siehe z.B. [5]). Daraus lässt sich ins-
besondere folgern: Bei einer Temperaturer-
höhung verkleinert sich die Dichte und da-
mit auch der Brechungsindex. 

Wie bereits erwähnt, ändert sich der Bre-
chungsindex auch bei größeren Schwan-
kungen der Dichte nur in einem sehr gerin-
gen Maße. Das bedeutet, dass es einer hoch-
empfindlichen Apparatur bedarf, um auch
geringe Änderungen darstellen zu können
– wie beispielsweise die Erwärmung der
Luft durch eine Kerze oder auch durch einen
Menschen. Erstaunlicherweise ist es aber
tatsächlich möglich, schon mit einem ver-
hältnismäßig geringen experimentellen
Aufwand dieses Ziel zu erreichen.

2 Verfahren zur Abbildung 
von Schlieren
2.1 Foucault-Aufbau
Zur Darstellung von Schlieren gibt es viele
verschiedene Methoden. Der einfachste op-
tische Aufbau entspricht dem des soge-
nannten Foucault-Tests für Hohlspiegel [6].
Er wurde ursprünglich bereits 1856 von Léon
Foucault entwickelt, um die Qualität von op-
tischen Instrumenten zu verbessern. Diese
Methode war auch Töpler bekannt, und er
verweist darauf auch in seinen Schriften:

„[..] desgleichen darauf hingewiesen, dass Fou-
cault zur Prüfung von spährischen Spiegeln ein
Verfahren einschlug, welches obiger Methode im
Princip nahe kommt, ohne von diesem Experimen-
tator zu weiteren wissenschaftlichen Zwecken
verwendet zu werden.“ [7, S. 34].

Für den Aufbau wird lediglich eine
(Punkt-) Lichtquelle, ein qualitativ hoch-
wertiger, sphärischer Hohlspiegel und eine
scharfe Kante (z.B. Rasierklinge) benötigt.
Abb. 1 zeigt den Strahlengang des prinzi-
piellen Foucault-Aufbaus. 
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Abb. 2: Foucault-Aufbau mit Kamera und zusätzlichem Beobachtungsspiegel für das Kameradisplay.

Abb. 3: Schlierenbildung bei Zuckerwasser in Wasser. Digitalfoto, erstellt mit dem Foucault-Aufbau
(gemäß Abb. 2).
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Um eine Punktlichtquelle zu erhalten,
wird beispielsweise das Licht einer Halo-
genlampe mit einer Kondensorlinse auf
eine (Iris-)Blende fokussiert, oder aber es
wird mit einer sehr hellen Leuchtdiode
(mit plangeschliffener Kunststofflinse) ge-
arbeitet. 

Quelle und Spiegel werden auf einer Op-
tischen Bank fixiert, wobei der Abstand die
doppelte Brennweite f des Spiegels betra-
gen muss. Über entsprechendes Stativma-
terial wird die Rasierklinge (möglichst an
der selben Optischen Bank) dicht neben
der Punktlichtquelle befestigt. Der Spiegel
ist dann so zu verschieben, dass er die
Lichtquelle exakt und randscharf auf die
Rasierklinge abbildet, also auch der Ab-
stand Kante-Spiegel 2f beträgt. Anschlie-
ßend wird die Klinge so verschoben, dass
die Abbildung der Lichtquelle etwa zur
Hälfte abgeblendet wird und die so durch-
gelassenen Lichtstrahlen auf einem Pro-
jektionsschirm dargestellt werden. 

Abb. 2 zeigt ein von uns verwendetes
Setup mit Elementen, wie sie in vielen
Sammlungen vorhanden sein dürften;
Abb. 3 eine Digitalaufnahme, die mit die-
ser Anordnung erzeugt wurde (Zuckerwas-
ser in Wasser).

Tipps & Tricks zum Foucault-Aufbau
Eine Schliere zwischen Spiegel und Ra-
sierklinge lenkt einige Strahlen derart ab,
dass diese entweder zusätzlich oder aber
gerade nicht mehr abgeblendet werden. In
jeden Fall verursacht sie eine Helligkeits-
änderung in einem bestimmten Bereich
des Bildes auf dem Schirm. 

Durch minimales Verschieben der Klin-
ge in alle Richtungen kann der Kompro-
miss zwischen Helligkeit und Kontrast des
Bildes optimiert werden. Um den Kontrast
zu verbessern, sollte man die Klinge ent-
lang der Schliere ausrichten, d.h. zum Bei-
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Abb. 5: Foucault-Aufbau ‚low-cost’ mit preiswertem Spiegel und LED als Punktlichtquelle.

Abb. 4: Bestandteile
des Foucault-Aufbaus 
„low-cost“: LED, preis-
werter Hohlspiegel im
Spiegelhalter aus dem
3D-Drucker und 
Rasierklinge.

Abb. 6: Standbild aus ei-
nem Video (gemäß Aufbau
aus Abb. 5).
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spiel bei der Aufnahme einer Kerzenflam-
me die Klinge vertikal dazu platzieren (also
längs der Wärmeströmung). 

Mit einer Abbildungslinse, die auf das
Schlierenobjekt gerichtet ist, wird auch
dieses auf dem Schirm sichtbar. Alternativ
lässt sich direkt hinter der Klinge auch eine
Kamera positionieren.

Aufgrund der hohen Lichtempfindlich-
keit von Digitalkameras können auch bei
normalen Lichtverhältnissen Aufnahmen
gemacht werden, während Schirmprojek-
tionen nur in abgedunkelten Räumen
möglich sind. Um ein ständiges, automa-
tisches Nachjustieren der Kamera zu ver-
meiden und um das zu untersuchende Ob-
jekt inklusive Schlieren scharf abzubilden,
sollten Fokus und Belichtungszeit ma-
nuell einstellbar sein. 

In unserem Aufbau befand sich das
Schlierenobjekt in etwa 0,5 m Entfernung
von der Kameraoptik, welche also auch auf
diese Entfernung fokussierbar sein musste. 

Werden Punktlichtquelle und Schlieren-
kante sehr dicht nebeneinander ange-
bracht, so kann das Schlierenobjekt direkt
vor dem Spiegel positioniert werden, ohne
dass es zu Doppelabbildungen kommt. Der
Kontrast wird auf diese Weise merklich ver-
stärkt. Bei einer völligen Überlappung der
zum Spiegel hinlaufenden und reflektier-
ten Strahlen spricht man von einer Double-
pass-Koinzidenzanordnung, sie ist jedoch
nur mit einem Strahlteiler oder einer ver-
spiegelten Klinge realisierbar.

2.2 Foucault-Aufbau „low-cost“
Der in Abschnitt 2.1 beschrieben Foucault-
Aufbau lässt sich auch mit sehr einfachen
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Abb. 7: Klassischer Aufbau nach Töpler mit Diffusor, Schlierenobjekt und Dokumentationskamera.

Abb. 8: Abbild eines Schlierenobjekts beim klassischen Aufbau nach Töpler – Flamme eines Teelichts
im Luftzug (Ausschnitt aus einem Video gemäß Aufbau aus Abb. 7).
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Abb. 9: Der Aufbau nach Töpler wird mit Gradsichtprisma zum Aufbau nach Schardin.
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Mitteln realisieren: Sehr preiswerte, für
Teleskope vorgesehene und damit ent-
sprechend hochwertige sphärische Kon-
kavspiegel (derzeit 12,90 €; [8]) und achro-
matische Linsen (derzeit 10,90 €; [9]) sind
u. a. bei Astromedia erhältlich. (Für Besit-
zer von 3D-Druckern finden sich auf unse-
rem Webserver unter http://didaktik. 
physik.fu-berlin.de/projekte/schlieren die
nötigen STL-Dateien für Linsen- respekti-

ve Spiegelhalter.) Als Lichtquelle nutzen
wir eine ultrahelle, weiße LED mit 25000
mcd, die beim Elektronikversand für ca.
0,30€ erhältlich ist; mit Vorwiderstand zur
Strombegrenzung. Ein darüber gezogenes
Röhrchen aus Schrumpfschlauch verhin-
dert seitliches Streulicht und engt den
Lichtaustritt auf etwa 2 mm ein. Alterna-
tiv kann auch ein Stückchen Alufolie mit
einer kleinen frontalen Öffnung an der

LED angebracht werden. Die Abbn. 4 und 5
zeigen die Bestandteile und den Foucault-
Aufbau „low-cost“. Mit einer Digitalkame-
ra lassen sich so mit einfachen Mitteln
auch eindrucksvolle Videosequenzen auf-
zeichnen (Abb. 6).

2.3 Klassischer Aufbau nach Töpler
Beim klassischen Aufbau nach Töpler wird
ebenfalls eine Halogenlampe mittels ei-
ner Kondensorlinse möglichst punktför-
mig auf eine Blende abgebildet. Um eine
gleichmäßige Ausleuchtung zu erreichen,
kann optional noch ein Diffusor vor die
Blende geschoben werden. Diese kann je
nach Bedarf als Loch- oder auch als
Schlitzblende ausgeführt sein. In seinem
sehr empfehlenswerten Buch stellt G. S.
Settles [10] auf S. 124 u. a. verschiedene
Blendenformen und ihren jeweiligen Nut-
zen vor. Wir begnügen uns bei unserem
Aufbau der Einfachheit halber mit einer
Lochblende. Diese Sekundärlichtquelle
wird über zwei hochwertige, achromati-
sche Linsen exakt auf eine verstellbare
Klinge abgebildet. Wie im Foucault-Auf-
bau wird diese dann vorsichtig vertikal
oder seitwärts aus der Abbildung geführt.
Das zu untersuchende Objekt befindet
sich zwischen den beiden Linsen, eine auf
das Objekt fokussierte Digitalkamera
dient zur Darstellung und Dokumenta-
tion (Abbn. 7 u. 8). 
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Abb. 10: Aufbau nach Schardin – Schlierenabbildung mit achromatischen Linsen (wie in Abb. 9 skizziert), jeweils mit einer Brennweite von 200 mm. Beide
Spalte sind vertikal geöffnet. In der wassergefüllten Küvette befindet sich ein Zuckerwürfel, der sich bereits nahezu aufgelöst hat (siehe auch Abb. 11).

Abb. 11: Schlierenabbildung beim Aufbau nach Schardin – Ausschnitt eines Videos des sich auflösen-
den Zuckerwürfels (aus Abb. 10).
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2.4 Schardin’sches 
Farbschlierenverfahren
Als Variante der klassischen Töpler-Metho-
de, die attraktivere, farbige Abbildungen
(Abb. 10) produziert und zudem Rück-
schlüsse auf die Stärke der Lichtablen-
kung liefern kann, ist das Schardin’sche
Farbschlierenverfahren bekannt. Hierbei
wird zusätzlich ein Gradsichtprisma nach
der Eintrittsblende in den Strahlengang
eingebracht. Das Prisma zerlegt das Licht
der Lichtquelle in seine spektralen Be-
standteile, sodass am Ort der Schlieren-
blende dann eine Abbildung des Eintritts-
spaltes, der in den einzelnen Spektralfar-
ben des beleuchtenden Lichtes aufgespal-
ten ist, entsteht. Durch eine Schliere wird
jedoch – je nach Stärke der Ablenkung –
Licht einer anderen Wellenlänge über die
Klinge auf die Beobachtungskamera ge-
lenkt. Dadurch wird der Bereich der Schlie-
re auf dem Schirm / der Kamera farblich
abgehoben. Die Skizze in Abb. 9 zeigt den
Schardin’schen Aufbau.

Tipps & Tricks zum Aufbau nach Schardin
Mit etwas weniger Aufwand und der Ver-
wendung preiswerter, chromatisch ver-
zeichnender Linsen ist ein ähnlicher Farb-
effekt erreichbar. Abb. 12 zeigt diese Varian-
te; eine qualitative Beurteilung des Schlie-
renobjektes ist damit nach unseren Erfah-
rungen jedoch nicht möglich. Auch die von
uns getesteten Vorschläge, den Schlieren-

spalt durch geeignete Farbfilter zu erset-
zen, waren weniger erfolgreich, da damit
die Helligkeit, also die Intensität der Abbil-
dung zu stark reduziert wurde. 

2.5 Die Moiré-Methode – eine hinter-
grundorientierte Schlierenabbildung
Bei der Schlierenfotografie mit der Moiré-
Methode werden Gitter anstelle von Linsen
oder Hohlspiegeln genutzt. Dabei gibt es
verschiedene Varianten, um diese Gitter zu
überlagern. Ein gängiger Aufbau ist in
Abb. 13 skizziert. Hier werden zwei Gitter
so hintereinander angeordnet, dass aus
Be obachterperspektive die Striche des Hin -
tergrundgitters genau auf den Zwi schen -
räumen des Vordergrundgitters liegen, so-
dass man zunächst nur ein schwarzes Bild
sieht.

Das zu untersuchende Objekt wird dann
zwischen die beiden Gitter gebracht. Steigt
nun warme Luft auf (z. B. einer Kerze), so
ändert sich lokal der Brechungsindex. Das
Licht wird anders gebrochen, und die Licht-
strahlen verlaufen nicht mehr gradlinig
vom Beobachter zum Hintergrundgitter.
Dadurch verschieben sich scheinbar die Li-
nien der beiden Gitter. So werden hellere
Stellen sichtbar und es entstehen Schlie-
renbilder.

Mithilfe eines Computers und geeigne-
ter Foto- bzw. Videobearbeitungssoftware
lässt sich der obige Aufbau auch auf nur
ein Gitter reduzieren. Es dient dann als
Hintergrund der Aufnahmen. Professio-
nelle Systeme rechnen per Kreuzkorrela-
tion des Hintergrundbildes (des Rasters)
mit dem aufgenommenen Bild oder Video,
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Abb. 12: Lifeaufnahme einer Schlierenabbildung mit chromatisch fehlerhaften Linsen (vgl. Abb. 9). Auch hier befindet sich in der wassergefüllten Küvette ein
Zuckerwürfel, der sich gerade auflöst. Es werden ebenfalls Linsen mit einer Brennweite von 200 mm verwendet, die beiden Spalte sind horizontal angeordnet. 

Abb. 13: Möglicher Aufbau zur Moire-Methode mit zwei Gittern (aus [11]).
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welches auch den Hintergrund beinhaltet,
die Schlierenabbildung des Objektes her-
aus. Diese Methode ist mittlerweile ziem-
lich fortgeschritten und kann sogar den
natürlichen Hintergrund als Referenzhin-
tergrund benutzen. Somit ist es sogar
möglich, auch sehr große Objekte zu verar-
beiten, wie Abb. 14 zeigt.

Die von uns erprobte Variante lässt sich
äußerst einfach realisieren: Unsere Soft-
warelösung subtrahiert nur das Hinter-
grundbild, also das Gitter ohne Objekt, von
einem Bild mit „Dichteunterschieden“.
Abb. 15 zeigt den prinzipiellen Aufbau. Als
Resultat ergeben sich im Idealfall ein-
drucksvolle Schlierenbilder (Abb. 16). 

Tipps & Tricks zum Moiré-Verfahren: 
Videoaufnahmen und Videobearbeitung
An dieser Stelle soll ein mögliches Vorge-
hen bei der Bildverarbeitung bzw. dem von
uns erfolgreich durchgeführten Ablauf der
Videokonvertierung beschrieben werden. 

Avidemux und Irfanview sind frei erhältli-
che Programme zur Bild- und Videobear-
beitung. Avidemux ist zudem für alle gängi-
gen Betriebssysteme erhältlich, Irfanview
nur für Windows. Die geforderte Funktion
der „Bildinvertierung“ bieten aber viele an-
dere Programme auch. Unter der Adresse
http://didaktik.physik.fu-berlin.de/projekte/
schlieren/daten/testvideo.mov liegt ein Vi-
deo bereit, mit dem die notwendigen
Schritte nachvollzogen werden können.

Vorgehen bei der Videoaufnahme
Zunächst wird ein schwarz-weißes Hinter-
grundbild (Gitter) mit einem Streifenraster
von etwa 1 mm auf dem Laserdrucker aus-
gedruckt und z.B. mit Magneten auf einer
Tafel befestigt. Eine Vorlage dazu findet
such auch unter http://didaktik.physik.fu-
berlin.de/projekte/schlieren. Je dichter die
Linien aneinander liegen, desto feinere Auf-
nahmen (Auflösung kleinerer Dichteunter-
schiede) sind möglich. Bei unseren Versu-
chen haben wir aber immer Gitter mit einen
Abstand von 1mm zwischen den Linien ver-
wendet, da kleinere Zwischenräume zu Auf-
lösungsproblemen geführt haben. 

Für unsere Aufnahmen verwendeten
wir eine HD-fähige Digitalkamera mit opti-
schen 10-fach-Zoom. Im Rahmen unserer
Experimente wurde allerdings auch die Ka-
mera eines iPhone-6 eingesetzt, und wir
waren erstaunt, dass auch damit sehr gute
Ergebnisse erzielt werden konnten.

Die zwingend auf einem stabilen Stativ
stehende digitale Videokamera (oder ein
Smartphone / Tablet) wird möglichst ent-
fernt platziert, bildfüllend auf das Raster
gezoomed und fokussiert.
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Abb. 14: Turbulenzen um einen Hubschrauber können mithilfe der Moire-Methode als Schlierenabbil-
dung sichtbar gemacht werden (aus [12]). 

Abb. 15: Prinzipieller
Aufbau nach der Moire-
Methode. Die Videobil-
der werden digital per
Software von einem vor-
ab und ohne Schlieren-
objekt aufgenommenen
Hintergrundbild des Git-
ters ‚subtrahiert’.

Abb. 16: Schlierenab-
bildung eines brennen-
den Gasfeuerzeugs
nach der Moiré-Metho-
de (gemäß Abb. 15).
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Jetzt kann die Videoaufnahme gestartet
und nach kurzem Warten z. B. ein Gasfeu-
erzeug zwischen Kamera und Raster ent-
zündet werden.

Vorgehen bei der Videobearbeitung
Das Video wird dann auf einen Computer
überspielt und digital nachbearbeitet:
1. Das Video mit Avidemux laden und den

ersten Frame (das erste Bild mit Gitter)
im Format „jpg“ speichern (mit: File →
Save as Image → Save as Jpeg). Avide-
mux erwartet dabei, dass zum Dateina-
men auch die Dateiendung (z.B. ‚back-
ground.jpg’) mit eingetragen wird!

2. Mit Irfanview das Bild laden, invertieren
(mit: Image → Negative → all Chan-
nels) und dann wieder speichern als z.B.
„invers.jpg“ (mit: File → Save as → „in-
vers.jpg“)

3. Weiter geht es nun wieder mit Avidemux:
Wenn das Video nicht mehr geladen ist,
weil sie das Programm verlassen haben,
so ist es (mit: File → Open) wieder neu
zu laden.

4. Das Format des Ausgabefiles muss fest-
gelegt werden (mit: Video Output →
Mpeg4AVC).

5. Der invertierte Videoframe wird nun als
Logo transparent über den kompletten
Film gelegt (mit: Video Output → Filters
→ add Logo). Nun das erzeugte Hinter-
grundbild „invers.jpg“ auswählen und
im Feld Alpha 125 eintragen und „ok“
anklicken. Rechts unten befindet sich
ein Button mit der Aufschrift „preview“,
der es gestattet, die vorgenommenen
Änderungen zu begutachten.

5. Meist muss noch die Helligkeit und der
Kontrast geändert werden (mit: Filters
→Color → Kontrast). Die Änderung ge-
schieht über Schieberegler. Es hat sich
bei unseren Experimenten als sinnvoll
erwiesen, den Kontrast (Contrast) weit
in Richtung Maximum und die Hellig-
keit (Brightness) in Richtung Minimum
zu verschieben. Der dritte Schieberegler
gestattet wieder eine Vorschau.

6. Nach diesen Änderungen werden die
Filter mit „ok“ übernommen.

7. Das jetzt fertige Video wird jetzt z.B. un-
ter dem Namen „moire“ gespeichert
(mit: File → Save → „moire“).

8. Je nach Länge des Videos und Compu-
terausstattung kann es einige Minuten
dauern, bis das Video konvertiert ist.

2.6 Schlierenabbildung nach der Moiré-
Methode – „life“ per Webcam oder per 
Tablet und App
Bei unseren Experimenten haben wir auch
Versuche mit einer HD-Webcam von Micro-

soft unternommen. Die Distanz zum Gitter
muss bei dieser Kamera naturgemäß sehr
kurz sein, mit etwa 15 cm waren auch da-
mit halbwegs brauchbare Ergebnisse zu er-
zielen. 

Unter http://www.didaktik.physik.fu-
berlin.de/projekte/schlieren findet sich
nun ein Programm, dass es gestattet, di-
rekt mit einem HTML5-fähigen Browser
(z.B. Google Chrome oder Firefox) in Echt-
zeit Schlierenabbildungen nach der Moi-
rè-Methode mit einer Webcam durchzu-
führen. 

Auf der Webseite finden sich ebenfalls
Informationen und ein Link zu einer neu-
en App (für das iPad), mit der nun mit ein-
fachsten Mitteln Experimente zu Schlie-
renabbildungen nach der Moiré-Methode
durchgeführt werden können (Abb. 17).    ■
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Weitere interessante Links
• hervorragende high-speed-Aufnahmen akus-

tischer Phänomene und Animation: https://
www.youtube.com/watch?v=px3oVGXr4mo&
feature=youtu.be (Stand 06/2015)

• Hargather und Settles (Schlierenexperten):
http://infohost.nmt.edu/~mjh/
Res-Optical.html (Stand: 06/2015)

• Zähringer: Vorlesungsscript „optische Mess-
verfahren“ (überzeugende Zusammenfassung
optischer Messmethoden): http://www.uni-
magdeburg.de/isut/LSS/Lehre/
Skripte_Messtechnik/Optische_
Messverfahren3_2012.pdf (Stand 06/2015)
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Abb. 17: Schlierenabbildung nach der Moiré-Methode per „App“ und iPad.


